
Дисциплина ППМУ и ДПМУ и МП при Г. Пашев

      

Бързи   връзки: Оценяване

  
    

Инсталация и конфигурация

  

Теми Курсови проекти по ППМУ и М П

  

Теми Курсови проекти по ДПМУ

  
    

За контакти

  

Съобщения за извънредни занятия

  

Учебна литература и полезни връзки

  
      

 

  

Достъп до онлайн материали чрез платформата Google Classroom:

  2021-2022 ППМУ СТД 3к. зад.  https://classroom.google.com/c/NDgwMzM3Njk4ODky?cjc=
2yuzhix   Базов курс (с най-много учебни материали):  П
У ФМИ 2021 ППМУ упр. - СТД 3к. ред.
 
https://classroom.google.com/c/MjgxMjkwNTc3NTg4?cjc=3wetca2
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Обща информация по отношение на оценяването:

  

За специалност СТД (редовни и задочни), оценяването става чрез:

  

Курсови проекти (отделни) за двете дисциплини ДПМУ, ППМУ. Темите за КП по ППМУ
се избират от списък тук . Темите за КП по ДПМУ могат да бъдат избрани от тук .

  

Минимални изисквания за КП:

  

1. Работа с БД sqlite3;

  

2. Минимум 2 activities;

  

Бонус точки се дават за:

  

1. Работа с мрежови заявки, многонишкова работа;

  

2. Работа със специфичен хардуер на мобилното устройство: bluetooth, gsm
modem (sms, data call);
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3. Работа с asyncTask, Map, ConcurrentMap, List, ArrayList, ConcurrentArrayList, др.

  

4. GPS и Google Maps компонента;

  

 

  

 

  

Оценките от упражнения се поставят по време на последните часове от триместъра или
по време на изпита от ас./гл.ас. Крайните оценки по съответната дисциплина се
поставят от титуляра на дисциплината по време на изпита.

  

За специалност СИ (задочни), оценяването става чрез:

  

1) Курсови задачи, изпълнени по време на третата част от 5 у.ч. упражнения; ИЛИ

  

2) Решаване на тест по време на третата част от 5 у. ч. упражнения;

  

Оценките се поставят по време на третата част от 5 у.ч. упражнения и могат да бъдат
коригирани от титуляр на дисциплината.

  

За специалност СИ (редовни), оценяването става чрез:

  

Курсови проекти по МП. Темите за КП по МП се избират от списък  тук .
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Оценките се поставят по време на последната седмица на триместъра и могат да бъдат
коригирани от титуляр на дисциплината.

  

 

  

  

 

  

Списък с теми за курсофи проекти:

  

Списък:  https://1drv.ms/w/s!ArI6oidlkCxomX5L9joU9XloqK1k

  

 

  

  

 

  

Разработвани курсови проекти по време на упражненията (Примерни курсови
проекти):

  

https://drive.google.com/drive/folders/0B2Sg-oFX9K4NYW9XSUFnSGdRZGM?usp=sharing
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Подготовка за провеждане на упражненията:

  

 

  

1) Андроид студио (Сваляне на архив и разархивиране):

  

https://drive.google.com/file/d/1QuYudYdE6_D29q779fOU60SArgsajEIj/view?usp=sharing

  

След сваляне и изтегляне се стартира bin/studio64.exe

  

2) Андроид SDK (Сваляне на архив и разархивиране в отделна директория):

  

Конфигурирано SDK може да изтеглите от тук: https://drive.google.com/open?id=1l8v8ADI
blCO2xXCtjVofhS9rzYgkVp4r

  

3) Настройване на Андроид студио за локацията на Android SDK.

  

File -> Sync Project with Gradle Files

  

Ако няма настроена папка за локация на Android SDK, ще поиска посочването на пътя до
Android SDK. За вече инсталирани среди чрез стандартен инсталатор, най-често SDK се
намира в " C:UsersfmiAppDataLocalAndroidsdk".
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Промяна на локацията на SDK става в Tools -> SDK Manager -> Android SDK
Location: Edit и новата папка се задава в отворилия се диалогов прозорец.

  

4) Настройване на виртуално устройство 

  

Tools -> AVD Manager -> + Create Virtual Device. Избира се Phone, Pixel 2XL. При нужда се
изтегля API (29, 28 напр.). Емулаторът се инсталира в SDK папката; При изтегляне на
SDK от линка по-горе, той вече е в нея и няма нужда от инсталация на емулатор.

  

  

Учебна литература и полезни връзки

  

Най-актуална версия на Android Studio за разработка можете да свалите от тук .

  

Проекти, работени по време на упражненията, можете да видите тук: https://drive.google
.com/drive/folders/0B2Sg-oFX9K4NYW9XSUFnSGdRZGM?usp=sharing

  

С цел подпомагане на работата за упражненията е създаден базов проект за Android
Studio, който можете да свалите от тук .

  

Книга за самоподготовка: "Практическо програмиране за Android" Денис Колисниченко,
второ преработено и допълнено издание, изд. "Асеневци", ISBN 978-954-8898-76-8;

  

Всеки студент задължително прави Курсов проект.Следва списък с примерни курсови
проекти, от които студентите могат да избират, а биха могли да предлагат други теми с
подобна трудност и при преценка на преподавателя, да бъдат одобрени.
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Теми за проекти по ДПМУ

          

№

  

Разпределен   на

  

Проект

  
    

1

  

 

  

Да се създаде част от дизайн за мобилно приложение за електронен   магазин за оръжия. Да се състои от следните activities: Главно   Activity, което реализира главно меню със следните   менюта: Категории, Артикули, Склад; като тези подменюта имат следните   елементи: Категории -> Преглед, Изтриване, Добавяне; Артикули ->   Преглед, Изтриване, Добавяне; Склад -> Доставка, Бракуване, Продажба. Да   се създаде Activity, което да дава интерфейс за   реализация на Преглед по категории с филтър по написано от потребител име на   категория, както и написано от потребител име на артикул. Да има подходящ   бутон с 2 състояния с текст “ Артикули, които не са на   склад“ , както и табличен изглед със самите артикули с   колони „Номер“, „Име артикул“ „Категория“ „Единична цена“.

  
    

2

  

 

  

Да се създаде част от дизайн за мобилно приложение за електронен   магазин за оръжия. Да се състои от следните activities: Изтриване нa артикул. Да има подходящ бутон с 2 състояния  с текст “ Артикули, които не са на склад“ , както и табличен изглед със самите артикули с колони „Номер“, „Име   артикул“ „Категория“ „Единична цена“. На всеки от редовете да има предвиден CheckBox, който ако е избран при натискане на бутон „Изтрий“   да изтрива съответния артикул. Да има и Activity ,   което да може да се ползва за добавяне/редакция на един артикул, реализиращо   форма с подходящи входни widgets за „Номер“, „Име   артикул“, „Категория“, „Единична цена“.

  
    

3
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Да се създаде част от дизайн за мобилно приложение за електронен   магазин за оръжия. Да се състои от следните activities: Бракуване, в което да има подходящ интерфейс за потребителя   да бракува даден артикул в определени количества в склада. Да има вид на   форма, в която в TableLayout  с възможност за страниране   или да могат да се скролват и избират чрез кликване на CheckBox във всеки ред на TableLayout -то артикули (може   избраните да са повече от един), както и да може да се задава брой на   артикулите, които ще се бракуват. Второто Activity да   реализира „Изглед на склад“ , в което да има TableLayout, което   да е със следните колони „Име артикул“, „Категория артикули“, „Наличност“. За   удобство на потребителя в същото Activity по-долу да   има форма за бързо добавяне/премахване на артикули в склада, като има   текстово поле, което при избран ред от TableLayout да   се попълва с името на избрания артикул, както и текстово поле за въвеждане на   числа, както и два бутона, съответно: „Добавяне“ и „Премахване“.

  
    

4

  

 

  

Да се създаде част от дизайн за мобилно приложение за електронен   магазин за оръжия.  Да се състои от следните activities: Главно   Activity, което да реализира подходящ интерфейс за потребителско   вписване с Username и Password. Да   има подходящ бутон с 2 състояния, който ако е кликнат, отдолу да се появяват   допълнителни елементи във формата, които да позволяват възстановяване на   забравена парола, като e-mail с който е регистриран и   името на потребителя, с което е регистриран. Второто Activity да позволява добавяне/редакция на категория, като има форма, подходяща   за това. Във формата трябва да има текстово поле с името на категорията,   както и изображение отдясно на него, което в последствие ще се показва, ако   името на тази категория е вече заето. Над формата да има TableLayout с възможност за страниране, което да показва вече наличните категории.

  
    

5

  

 

  

Да се създаде част от дизайн за приложение „Активни потребители“,   което да има за цел докладване на нередности в търговската мрежа.  Главно Activity, което да реализира подходящ интерфейс за потребителско   вписване с Username и Password. Да   има подходящ бутон с 2 състояния, който ако е кликнат, отдолу да се появяват   допълнителни елементи във формата, които да позволяват възстановяване на   забравена парола, като e-mail с който е регистриран и   името на потребителя, с което е регистриран. Това Activity да   предвижда възможност за вписване през Facebook, Google   Account, LinkedIn и др. Второ Activity, което   да реализира списък с подадени от текущия потребител сигнали дотук, както и с   бутон за подаване на нов сигнал. Списъкът с подадените вече сигнали да се   реализира с TableLayout, отдолу да има бутони за   страниране на елементите в TableLayout-a или скролер   (по избор). Всеки ред от таблицата да има CheckBox, който   при избиране и кликване на бутон „ Delete” да позволява   изтриване на подадения сигнал.

  
    

6

  

 

  

Да се създаде част от дизайн за приложение „Активни потребители“,   което да има за цел докладване на нередности в търговската мрежа.  Да се   създаде Activity, в което да има подходяща форма за   добавяне на нов сигнал. Един сигнал има Заглавие, Дата и час на добавяне   (това поле ще се попълва автоматично и трябва да е забранено за редакция),   скрито поле, което да съдържа GPS координатите,   където е потребителят в момента на подаването на сигнала, дата в която   потребителят е забелязал за първи път нарушение от такъв характер (с DatePicker), SurfaceView, което ще се ползва за показване   на заснет от камерата образ на самото нарушение, за което се отнася сигнала, Бутон за изпращане на нарушението и ProgressBar, който ще уведомява потребителя за забавянето при предаване на   нарушението към сървиса.
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7

  

 

  

Да се създаде част от дизайн за приложение „Светците на деня“, което   да реализира следните Activities: Главно Activity, което да показва TableLayout с   възможност за скролване с наличните светци за текущия ден съгласно църковния   календар. При кликване на конкретен светец ще се зарежда Activity с информация за конкретния светец в следния вид: Име, година на   раждане, година на смърт, дата на канонизация, икона, кратко житие на   светеца. Да има бутони за споделяне на информацията за светеца в социални   мрежи (Facebook, Twitter, LinkedIn, Google+ и др.).

  
    

8

  

 

  

Да се създаде част от дизайн за приложение „Шах“ със следните Activities: Главно Activity, което да реализира меню за   работата с игрите на шах, вкл. „Нова игра“, „Продължи стара игра“, „Запази   текущата игра“. Да има Activity с TableLayout, който графично да наподобява шахматното поле с белите и черни   квадрати. Да има отгоре бутон „ Undo”, който ще се   използва за връщане играта с един ход назад, както и бутон Menu, който ще връща към главното activity.

  
    

9

  

 

  

Да се създаде част от дизайн за приложение „Новинарски портал“. В   главното Activity да има бутон, показващ меню с   категориите новини, бутон „лупичка“, който при кликване да показва Activity „Търсене“, както и бутон „ Refresh”  за обновяване на текущата страница. Отдолу да има скролируемо TableView с новините в текущо избраната категория. В   антетката на таблицата ще има името на категорията. Менюто с категориите ще   съдържа следните категории „Начало“, „Новини“, „Региони“. Аналогично да се   създаде дизайн за Activity „Региони“, което да   съдържа списък с региони, като при кликване на регион да показва новини от   там.

  
    

10
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Да се създаде част от дизайн за мобилно приложение „Портал за   продажби“. Да реализира с подходящ интерфейс, разпределен по Activities по избор на студента, който да има най-малко   следните елементи: бутони с изображения за: „Всички категории“, „Запитване   към магазина“, „Най-популярни“, „Най-ново за този месец“, „Продукти в   промоция“. В ScrollView да показва първите 3   подкатегории от категории „Мобилни телефони“, „Компютърна техника“, „Аксесоари   за мобилни телефони“. Да има TableLayout, показващ   най-продавани артикули.

  
    

11

  

 

  

Да се създаде част от дизайн за мобилно приложение „Месинджър“.    Главното Activity да има отгоре бутони с 2 състояния:   Скорошни, Контакти, Заявки за свързване. Ако е натиснат бутон, отдолу в TableLayout, който е скролируем се показват кратки изгледи   на съобщенията. Да има Activity за преглед на   съобщение. Едно съобщение може да има следните елементи: Заглавие, текст,   Прикрепени снимки, прикрепени файлове. Да се създаде и Activity за ново съобщение.

  
    

12

  

 

  

Да се създаде част от дизайн за приложение „Дама“ със следните Activities: Главно Activity, което да реализира меню за   работата с игрите на дама, вкл. „Нова игра“, „Продължи стара игра“, „Запази   текущата игра“. Да има Activity с TableLayout, който графично да наподобява игралното поле на „Дама“. Да има отгоре   бутон „ Undo”, който ще се използва за връщане играта   с един ход назад, както и бутон Menu, който ще връща   към главното activity.

  
    

13

  

 

  

Да се създаде дизайн за приложение, подобно на mapstr. Да използва MapFragment. В такова приложение,   потребителят може да добавя списък с локации на конкретна позиция в картата.   Всяка локация се характеризира с GPS координати, Име   на локацията, Категория на локацията. Да се създадат Activities, както и подходящо меню за: Добавяне/редакция/изтриване на   локация/категория на локация. Да има бутони за споделяне в социални мрежи на   текуща локация.
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14

  

 

  

Да се създаде дизайн за приложение „Организатор на задачи“. В   главното Activity да има отгоре: бутон за преглед на   всички незавършени задачи, бутон за добавяне на нова задача, бутон, водещ към   Activity, което да позволява закупуване на платена   версия на същото приложение, с премахнати реклами. Отдолу да има CalendarView с възможност за избор на ден. При избран ден и   при кликване на бутон за добавяне на нова задача да се зарежда Activity за добавяне на задача със следните атрибути: Име,   начален час, краен час, приоритет (без приоритет, нисък, среден, висок),   Нотификации (да/не) (показва дали да са включени нотификациите за тази   задача), Описание на задачата. В главното Activity да   има ImageView, което да представлява реклама, с опция   да се скрива след 30 секунди след зареждане на Activity -то.

  
    

15

  

 

  

Да се създаде част от дизайн за приложение „Съвестни шофьори“, което   да има за цел докладване на нередности в пътната мрежа.  Да се създаде Activity, в което да има подходяща форма за добавяне на нов   сигнал. Един сигнал има Заглавие, Дата и час на добавяне (това поле ще се   попълва автоматично и трябва да е забранено за редакция), скрито поле, което   да съдържа GPS координатите, където е потребителят в   момента на подаването на сигнала, дата в която потребителят е забелязал за   първи път нарушение от такъв характер (с DatePicker), SurfaceView, което ще се ползва за показване на заснет от камерата образ на самата   пътна нередност (например, дупка, липсваща мантинела, др.), за която се   отнася сигнала, Бутон за изпращане на нарушението и ProgressBar, който ще уведомява потребителя за забавянето   при предаване на нарушението към сървиса.

  
    

16

  

 

  

Да се създаде част от дизайн за приложение за провеждане на анкети.   Да има Главно Activity, което със скролируемо TableLayout да предлага списък от категории на анкетите и   при кликване на конкретна категория по аналогичен начин да се зарежда списък   с активните анкети в конкретна категория. При кликване на конкретна анкета,   ще се зарежда Activity за отговор на анкетата. Всяка   анкета има заглавие, описание, опции (като потребител избира валидната за   него опция с кликване на CheckBox). Да има бутон за   съхраняване на отговора и ProgressBar, който да   показва забавянето при изпращане на отговора към Service. Да   има Activity, което да показва резултатите от   конкретна анкета със заглавие и подходящ Chart. Може   да се използва библиотека като MPAndroidChart .

  
    

17
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Да се създаде дизайн за приложение на туристическа агенция,   предлагаща организирани екскурзии.  Главното Activity предоставя   филтри за търсене на екскурзии по следните категории: дата от; дата до;   Континент; регион в континент; минимален брой оставащи места в екскурзията;   Брой дни; минимална категория на хотелите в екскурзията, както и  скролируем TableLayout, който показва самите екскурзии, отговарящи на   зададените филтри. При кликване на конкретна екскурзия, излиза Activity показващо повече информация за екскурзия като   Заглавие, галерия със снимки, брой дни, информация за всеки ден, информация   за допълнителни екстри (напр. разходка в музей Лувър с предплатени билети). В   това Activity има бутон Резервирай, при кликването на   който, ще се отваря Activity за резервация на   избраната екскурзия, която включва: брой възрастни над 7г. възраст, брой   деца, е- mail за контакт, адрес за контакт с (Държава,   Град, П.К., Улица ред 1, Улица ред 2), телефон за контакт.

  
    

18

  

 

  

Да се създаде дизайн за приложение „Съветник за тренировки“. Главното   Activity да съдържа меню с любими тренировки, бутон с   картинка, при кликването на който да се показва текущ потребителски профил   със снимка на потребител, Име на потребител, брой изгорени калории.  Да има   подходящ скролируем Layout, който да показва списък с   тренировки, като списъкът се състои от главна снимка, продължителност в   минути, ниво на интензивност (високо, средно, ниско), ниво на трениращ   (начинаещ, среден, напреднал). При кликване на бутон „Тренировки“, да се   зарежда списък с категории на тренировки (например: за сила, за устойчивост,   за бързина, др.). При кликване на категория тренировки, ще се зарежда Activity с TableLayout със   съответните тренировки в категория. При кликване на конкретна тренировка се   зарежда Activity за провеждане на тренировка, което   се състои от брояч: колко секунди са преминали, заглавие на тренировката и VideoView, което зарежда и пуска видеото на тренировката.

  
    

19

  

 

  

Да се създаде част от дизайн за приложение „Моите часове за деня“,   което да подпомага студент да проследява по-лесно дневната си учебна програма   , което да реализира следните Activities: Главно Activity, което да показва TableLayout с   възможност за скролване с наличните часове за текущия ден съгласно учебна   програма. При кликване на конкретен час, ще се зарежда Activity с информация за конкретния час в следния вид: Име дисциплина, име   преподавател, номер на текуща седмица, съгласно академичния календар. Да има   бутони за споделяне на информацията за часа в социални мрежи (Facebook, Twitter, LinkedIn, Google+ и др.).

  
    

20

  

 

  

Да се създаде част от дизайн за приложение „Корупционни сигнали“,   което да има за цел докладване на корумпирани служители в държавната   администрация.  Главно Activity, което да реализира   подходящ интерфейс за потребителско вписване с Username и   Password. Да има подходящ бутон с 2 състояния, който   ако е кликнат, отдолу да се появяват допълнителни елементи във формата, които   да позволяват възстановяване на забравена парола, като e-mail с който е регистриран и името на потребителя, с което е регистриран.   Това Activity да предвижда възможност за вписване   през Facebook, Google Account, LinkedIn и др. Второ Activity, което да реализира списък с подадени от текущия   потребител сигнали дотук, както и с бутон за подаване на нов сигнал. Списъкът   с подадените вече сигнали да се реализира с TableLayout, отдолу   да има бутони за страниране на елементите в TableLayout-a или   скролер (по избор). Всеки ред от таблицата да има CheckBox, който   при избиране и кликване на бутон „ Delete” да позволява   изтриване на подадения сигнал. Да има Activity за   добавяне на сигнал, като всеки сигнал съдържа: Заглавие; Име на служител, за   който се отнася; Име на отдел; Име на агенция, Име на министерство; Описание   на сигнала.

  
    

21
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Да се създаде дизайн за приложение „Видео уроци за програмисти“. Главното   Activity да съдържа меню с любими уроци, бутон с   картинка, при кликването на който да се показва текущ потребителски профил   със снимка на потребител, Име на потребител, изгледани уроци.  Да има   подходящ скролируем Layout, който да показва списък с   уроци, като списъкът се състои от главна снимка, продължителност в минути,   ниво на трудност (високо, средно, ниско), ниво на обучаван (начинаещ, среден,   напреднал). При кликване на бутон „Уроци“, да се зарежда списък с категории   на уроци (например: за уеб приложения, за декстоп приложения, др.). При   кликване на категория уроци, ще се зарежда Activity с   TableLayout със съответните уроци  в категория. При   кликване на конкретен урок се зарежда Activity за   провеждане на урок, което се състои от брояч: колко секунди са преминали, заглавие   на урока и VideoView, което зарежда и пуска видеото   на тренировката с възможност за пауза.

  
    

22

  

 

  

Да се създаде част от дизайн за мобилно приложение „Онлайн аптека“.   Да реализира с подходящ интерфейс, разпределен по Activities по избор на студента, който да има най-малко следните елементи: бутони   с изображения за: „Всички категории“, „Запитване към магазина“, „Най-популярни“,   „Най-ново за този месец“, „Продукти в промоция“. В ScrollView да показва първите 3 подкатегории от категории „Козметика“, „Антивирусни   препарати“, „Ваксини“. Да има TableLayout, показващ   най-продавани артикули.

  
    

23

  

 

  

Да се създаде част от дизайн за мобилно приложение „Каталог на   ресторанти“. Главното Activity ще показва скролируем TableLayout с най-близките до потребителя ресторанти,   подредени по намаляващ ред на тяхната категория. Всеки ресторант в Layout -а ще е представен с главна снимка, име на   ресторанта, оценка, получена по каталог. При кликване на конкретен ресторант,   ще се зарежда Activity с информация за съответния   ресторант: Главна снимка, Име, Оценка, Достойнства, Недостатъци, Адрес,   Телефон за поръчка, MapFragment със заредена карта с   точка в координатите, където е адреса на ресторанта. Да има бутони за   споделяне на конкретен ресторант в социални мрежи.

  
    

24

  

 

  

Да се създаде част от дизайн за мобилно приложение, подпомагащо   работата на мрежови администратори при поставяне на Wireless   Access Points из сграда. Да има Activity с TableLayout, което да предоставя списък с имена на налични   мрежи и колко dB е силата на сигнала на конкретната   мрежа от списъка. При кликване на конкретна мрежа, да се показва инфо за нея   в отделно Activity, което да съдържа името на   мрежата, начина на кодиране на сигнала в мрежата, колко dB e измерената сила в тази точка за тази мрежа.
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25

  

 

  

Да се създаде част от дизайн за мобилно приложение PriorityFeed ,   работещо с Facebook Graph API, което да предоставя   функционалност за приоритизиране на постингите в News Feed- а   на потребителя. Всяка една новина от NewsFeed -а излиза   в главното Activity, заедно с число: изчислен   коефициент на важност на новината, на базата на зададените лични критерии за   приоритизиране. При кликване на конкретна новина, да се зарежда в Activity самата новина в WebView. Задаването   на правилата на приоритизиране да става в отделни Activity, в   което се задават тези приятели на потребителя, които са по-важни, както и   думи, които трябва да съдържат важните постове, както и думи, които не трябва   да съдържат важните постове.

  
    

26

  

 

  

Да се създаде дизайн за приложение „Каталог книги“. Главното Activity да съдържа меню с любими книги, бутон с картинка,   при кликването на който да се показва текущ потребителски профил със снимка   на потребител, Име на потребител, брой свалени книги.  Да има подходящ   скролируем Layout, който да показва списък с книги,   като списъкът се състои от главна снимка, брой страници, Жанр. При кликване   на бутон „Книги“, да се зарежда списък с жанр на книги (например: фантастика,   IT и др.). При кликване на категория книги, ще се   зарежда Activity с TableLayout със   съответните книги в категория. При кликване на конкретна книга, се зарежда Activity за четене, което се състои от брояч: колко секунди   са преминали, заглавие на книгата и WebView, което   зарежда самата книга.

  
    

27

  

 

  

Да се създаде дизайн за мобилно приложение „Игра Тетрис“. Да се   създаде TableLayout с квадратите, които по време на   изпълнение на програмата динамично ще стават светли или тъмни, в зависимост   от “ падащите ”  фигури. Да има   бутони за преминаване наляво, надясно, завъртане наляво, завъртане надясно на   падащата фигура. Да има подходящ изглед за нивото на играта и за спечелените   точки.

  
    

28
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Да се създаде дизайн за мобилно приложение за ресторант, в който   поръчките вместо с викане на сервитьор/ка, стават с мобилното приложение.  В   главното Activity има текстово поле, в който   потребителя въвежда номера на масата си и при натискане на бутон влиза в Activity за поръчка. Това Activity съдържа   филтър по име на артикула и група от радио бутони на категории атрикули   (напр. безалкохолни, алкохолни коктейли и т.н.). Съдържа и TableLayout с възможност за страниране, който показва намерените артикули,   отговарящи на зададения филтър. При кликване на конкретен артикул ще излиза Activity за поръчка на артикула, в което има снимка, име,   допълнителна информация за него, текстово поле, в което да въведе брой и   бутон за добавяне към поръчката с връщане към главното Activity. В главното Activity да има подходящ бутон за   финализиране на поръчката, който да показва сметката дотук.

  
    

29

  

 

  

Да се създаде дизайн за мобилно приложение „Умен градски транспорт“.   Да има необходимите Activities за потребителски   логин, възстановяване на забравена парола и логин през акаунти на социални   мрежи. Да има Activity с MapFragment, което да показва най-близките спирки до потребителя на картата и при   кликване на конкретна спирка, да зарежда Activity, в   което се показва разширена информация за тази спирка: Име, кои линии минават   през нея, кои са най-скорошните линии, които ще минават и до колко минути ще   дойдат. Информацията да се зарежда в подходящи скролируеми TableLayouts или ListViews. 

  
    

30

  

 

  

Да се създаде дизайн за мобилно приложение „Агенция за недвижими   имоти“.  Да има необходимите Activities за   потребителски логин, възстановяване на забравена парола и логин през акаунти   на социални мрежи. Да има Activity с MapFragment, което да показва най-близките недвижими имоти   за продан до потребителя на картата и при кликване на конкретен имот, да   зарежда Activity, в което се показва разширена   информация за този имот: Име, метри до най-близката спирка на градския   транспорт, колко квадрата, цена на квадрат, обща цена, снимки от имота (галерия   със следните елементи: ImageView, бутон за Next и Previous ).   Да има бутон „поръчай оглед“, за да може клиента да поръча оглед на този   имот. Да има бутони за споделяне на конкретен имот в социални мрежи.

  
        

 

  

  

  

 Обявления за извънредни занятия
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За допълнителна информация и въпроси:

  

гл. ас. д-р инж. Георги Пашев;

  

e-mail: georgepashev (at) uni-plovdiv.bg;
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